Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by the laws, POWERDIRECTOR IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH POWERDIRECTOR AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan, Republic of China.

PowerDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters: CyberLink Corporation, 15F, No.100, Min-Chiuan Road, Hsin-Tian City, Taipei Hsien, Taiwan, R.O.C.

Web site: support.gocyberlink.com

Telephone #: 886-2-8667-1298

Fax #: 886-2-8667-1467

Copyright © 1999-2001 CyberLink Corporation, Taipei, Taiwan, ROC
# TABLE OF CONTENTS

## 1 Introduction ................................................................. 1

- The Digital Video Universe ........................................... 3
- The DV Format: A Brief History ....................................... 3
- FireWire ............................................................................ 4
- System Requirements ..................................................... 5
  - Hardware Requirements ............................................... 5

## 2 A Visual Overview ....................................................... 7

1. Library ........................................................................... 9
2. Storyboard .................................................................... 10
3. Preview Window .......................................................... 11
4. Modes Wheel ............................................................... 13
  - Capture Mode ............................................................. 14
    - DV VCR Capture Mode .............................................. 15
    - DV Batch Capture Mode ......................................... 17
  - Trim Mode .................................................................... 19
  - Speed Mode .................................................................. 21
  - Titles Mode ................................................................... 22
  - Effects Mode ............................................................. 23
  - Picture-in-Picture Mode .............................................. 24
  - Audio Mode ............................................................... 25
  - Transitions Mode ....................................................... 26

## 3 The Basics ...................................................................... 27

- Importing into the Library ............................................... 27
- Previewing your Library Files ......................................... 29
- Detecting Scenes .......................................................... 31
- Storyboard Functions ................................................... 34
- Menu Selections ............................................................ 36
  - File Menu .................................................................... 36
Capturing Content ................................................. 45
Capturing Video and Audio .................................................. 46
Capturing from DV Camcorders ......................................... 50
  Capturing from DV Camera Mode .................................. 50
  Capturing from DV VCR Mode ...................................... 53
Batch Capturing from DV Camcorders ................................. 56

Trimming Video .......................................................... 61
Trim Mode ...................................................................... 61
  Splitting the Video File .................................................. 63
  Trim Mode for Image Files .............................................. 64

Altering Speed and Supplying Video Effects .......... 67
Altering Speeds .......................................................... 67
  Supplying Video Effects ............................................... 69

Adding Titles and Transitions ................................. 73
Titles Mode ............................................................. 73
  Transitions Mode ......................................................... 77

Adding Audio and Pictures ................................. 79
Audio Mode .......................................................... 79
  Master Audio ........................................................... 82
  Picture-in-Picture Mode ................................................. 84
    Applying Image Color Filters ...................................... 85
  Master Watermark ....................................................... 86
CHAPTER 1: INTRODUCTION

Ever thought about directing your own movie? How about having all the creative controls and being in charge of the entire editing and post-production process? Well, today’s computing technology has made all this possible for anyone who has recording devices, capture devices, a computer, and of course, the sensational new software application, PowerDirector Standard.

Admittingly, video editing software is not without its drawbacks. Since the advent of computers and its incredible growth in usage and processing speed power, video editing software applications have taken off to astronomical heights. Yet, a great inherent limitation, such as requiring a huge amount of disk space because of the raw video data it captures, still remains. This is why many still choose to edit with analog devices.

What makes PowerDirector the megastar of its industry in one quick flash is its ability to save precious producing time because of its Smart Video Rendering Technology (SVRT). Say goodbye to raw video data, which is usually captured in .AVI format, and say hello to plenty of hard drive space with the MPEG and DV AVI formats. No additional compression nor decompression is required when producing scenes with MPEG or DV AVI formats that do not contain effects, which saves you huge amounts of time compared to our competitors that compress and decompress the entire movie regardless!

And adding SVRT wonderful features that simply enthrall, amaze and stupefy including:

- altering video speeds
- detecting scenes
- capturing directly from DV camcorders in real-time or non real-time
- adding titles to clips
- adding audio streams to clips
- picture-in-pictures (adding video or images to an existing video clip)
Chapter 1

- a huge collection of transitions, video and titles effects
- master audio files
- watermarks

...and there is nothing left to be desired!
The Digital Video Universe

Profit outlooks and shrinking demand in the technology industry notwithstanding, the digital video revolution is well underway. There are still home videos to be edited, videos to be distributed, and full-length movies to be produced. In previous generations, video editing and recording was accomplished through analog means by video professionals who had access to high-priced machinery and video equipment. Thus, many of those who wished to edit home footage or videos, if they were lucky enough to have it recorded in the first place, never had the chance to display their creative prowess when it came to video editing unless it involved enrolling in film schools and obtaining access to production studios.

When the computer descended upon our lives and immersed itself in our world, it was only a matter of time until processing speeds were incredibly fast and disk space was vast enough to begin editing video at home with software applications that didn’t require expensive video specialists, equipment or any other gadgets.

And coinciding with the computer industry’s major influence was the birth of the DV (digital video) format, an international standard intended for consumer use, back in 1995.

The DV Format: A Brief History

Like a seamless emergence and natural coalescence with desktop video editing, the advent and proliferation of DV camcorders were sure to spark continued interest in the infinite possibilities of digital video. What began back in 1995 and a DV format agreement reached by a consortium of companies that included Hitachi, Ltd., Sony Corp, Sharp Corporation, Thompson Multimedia, Mitsubishi Electric Corporation, Victor Corporation of Japan (JVC), Matsushita Electric Industrial Corp. (Panasonic), Philips Electronics, Sanyo Electric Co. Ltd., and Toshiba Corporation, is still being ironed out until this day in terms of a consensual format.

The frontrunners at the time and still are until this day, are Sony and Matsushita (Panasonic), which beat out the competition with their consumer releases hitting the market first. Soon after though, the format wars began with professional DV variants such as DVCAM (Sony) and DVCPRO (JVC) despite the DV format agreement. Luckily, the basic DV format is still intact, but other factors were altered (i.e. tape type, track pitch, and width) so we are still left with backward-compatible formats or incompatible formats between models from differing companies. Hopefully, this won’t impact or trickle down to the consumer segment anytime soon.

What exactly is the DV format then? To start with, it has a 5:1 compression ratio and its compression technology is quite similar to MPEG (e.g. DVD Video format).

Chapter 1

The difference is that it relies more on intraframe compression where each compressed frame will depend entirely on itself and not on data from preceding or following frames like MPEG. However, the DV format does incorporate the use of adaptive interfield compression where two extremely similar interlaced fields of a frame will be compressed together to save space.

The analog generation is slowly witnessing its demise. There is still room left for analog technology, but as the DV format perfects its compression technology and enhances their non-linear editing (NLE) friendliness, the analog generation will soon be outdated, fainting memories from a bygone era. Add to this the continued popularity of video editing software and the uncompromising blazing speed of computer processing power, and the perfect union between DV recording and editing couldn’t be any more natural or fitting.

**FireWire**

In the early courting stages of video editing software and DV format recording, there had to be an intermediary between the two technologies to make it a success, because as you know from analog transference, there is always data lost from the original source. FireWire, or IEEE-1394, is this unerring technology when it comes to data loss, as in “lossless” transfer. A serial data transfer protocol and interconnection (bi-directional) system, FireWire transmits digital video (DV) offering a higher transfer rate and incorporating the use of hot-plugging technology (i.e. connecting and disconnecting without shutting down the host computer).
System Requirements

- Windows 98SE, ME, 2000, XP

**Hardware Requirements**

- Pentium II 450 or above

*Note: For hardware requirements when capturing from your DV camcorder or analog devices, please refer to the most up-to-date Readme.*

- 200MB of free hard drive disk (HDD) space
- Video capture devices (optional)
  - capture cards (PCI, USB, FireWire or other FireWire formats)
  - DV camcorder or DV VCR
  - analog camcorders or VCRs in 8mm, Hi8, VHS, VHS-C or Beta formats
  - digital camera
  - PC camera
- Playback
  - Internet Streaming: Pentium II 266 with MMX Technology, Microsoft Windows Media Player 7.0, IE 5.0
  - Desktop Slide Show: Pentium II 266 with MMX Technology
CHAPTER 2: A VISUAL OVERVIEW

Note: Images of the Modes Wheel contained in this chapter will be based on the PowerDirector Pro version.

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>i-Power</td>
</tr>
<tr>
<td>B</td>
<td>Minimize</td>
</tr>
</tbody>
</table>

Activates i-Power on the Web for resources
Minimizes PowerDirector
## Chapter 2

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C Exit</td>
<td>Exits PowerDirector</td>
</tr>
<tr>
<td>D Volume</td>
<td>Adjusts volume</td>
</tr>
<tr>
<td>1 Library</td>
<td>Refer to “1. Library” on page 9</td>
</tr>
<tr>
<td>2 Storyboard</td>
<td>Refer to “2. Storyboard” on page 10</td>
</tr>
<tr>
<td>3 Preview Window</td>
<td>Refer to “3. Preview Window” on page 11</td>
</tr>
<tr>
<td>4 Modes Wheel</td>
<td>Refer to “4. Modes Wheel” on page 13</td>
</tr>
</tbody>
</table>
1. Library

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Show All Media Shows all media files in Library</td>
</tr>
<tr>
<td>B</td>
<td>Show Video Shows all video files in Library</td>
</tr>
<tr>
<td>C</td>
<td>Show Audio Shows all audio files in Library</td>
</tr>
<tr>
<td>D</td>
<td>Show Images Shows all image files in Library</td>
</tr>
<tr>
<td>E</td>
<td>Detect Scenes Detects scenes for a selected file in the Library</td>
</tr>
<tr>
<td>F</td>
<td>Import Media Imports media files</td>
</tr>
<tr>
<td>G</td>
<td>Import Directory Imports all media files in a directory</td>
</tr>
<tr>
<td>H</td>
<td>Large Icons Displays Library media files as large icons</td>
</tr>
<tr>
<td>I</td>
<td>Details Displays Library media files with file details</td>
</tr>
</tbody>
</table>
## Chapter 2

### 2. Storyboard

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Play Movie</td>
</tr>
<tr>
<td>B</td>
<td>Master Watermark</td>
</tr>
<tr>
<td>C</td>
<td>Master Audio</td>
</tr>
<tr>
<td>D</td>
<td>Scroll Left</td>
</tr>
<tr>
<td>E</td>
<td>Scroll Right</td>
</tr>
</tbody>
</table>

- **A** Play Movie: Plays your movie (preview before producing)
- **B** Master Watermark: Activates Master Watermark mode
- **C** Master Audio: Activates Master Audio mode
- **D** Scroll Left: Scrolls Storyboard left
- **E** Scroll Right: Scrolls Storyboard right
3. Preview Window

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Pause</td>
</tr>
<tr>
<td>B</td>
<td>Stop</td>
</tr>
<tr>
<td>C</td>
<td>Play</td>
</tr>
<tr>
<td>D</td>
<td>Start</td>
</tr>
<tr>
<td>E</td>
<td>Apply</td>
</tr>
<tr>
<td>F</td>
<td>End</td>
</tr>
<tr>
<td>G</td>
<td>Previous Frame</td>
</tr>
<tr>
<td>H</td>
<td>Next Frame</td>
</tr>
</tbody>
</table>

Pauses file

Stops playing file

Plays file

To start of file

Applies clip to Storyboard (if applicable)

To end of file

Moves to previous frame

Moves to next frame
<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I Record</td>
<td>Records file (if applicable depending on mode)</td>
</tr>
</tbody>
</table>
4. Modes Wheel

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Preview Mode</td>
</tr>
<tr>
<td>B</td>
<td>Trim Mode</td>
</tr>
<tr>
<td>C</td>
<td>Speed Mode</td>
</tr>
<tr>
<td>D</td>
<td>Titles Mode</td>
</tr>
<tr>
<td>E</td>
<td>Effects Mode</td>
</tr>
<tr>
<td>F</td>
<td>PiP Mode</td>
</tr>
<tr>
<td>G</td>
<td>Audio Mode</td>
</tr>
<tr>
<td>H</td>
<td>Transitions Mode</td>
</tr>
<tr>
<td>I</td>
<td>Capture Mode</td>
</tr>
<tr>
<td>J</td>
<td>Produce Movie</td>
</tr>
</tbody>
</table>

Switches to the default Preview Mode
Switches to Trim Mode
Switches to Speed Mode
Switches to Titles Mode
Switches to Effects Mode
Switches to Picture-in-Picture (PiP) Mode
Switches to Audio Mode
Switches to Transitions Mode
Switches to Capture Mode
Switches to Produce Movie
Capture Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Audio Capture</td>
</tr>
<tr>
<td>B</td>
<td>Video Capture</td>
</tr>
<tr>
<td>C</td>
<td>DV Capture</td>
</tr>
<tr>
<td>D</td>
<td>Setup</td>
</tr>
</tbody>
</table>

- **A**: Audio Capture - Captures audio source only
- **B**: Video Capture - Captures video and audio source (if applicable)
- **C**: DV Capture - Captures DV source
- **D**: Setup - Setups for audio/video sources and profiles
## DV VCR Capture Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Total Time</td>
</tr>
<tr>
<td>B</td>
<td>Pause</td>
</tr>
<tr>
<td>C</td>
<td>Current Tape Timecode</td>
</tr>
<tr>
<td>D</td>
<td>Stop</td>
</tr>
<tr>
<td>E</td>
<td>Play</td>
</tr>
<tr>
<td>F</td>
<td>Seek</td>
</tr>
<tr>
<td>G</td>
<td>Rewind</td>
</tr>
<tr>
<td>H</td>
<td>Fast Forward</td>
</tr>
<tr>
<td>I</td>
<td>Previous Frame</td>
</tr>
</tbody>
</table>

- **A** Total Time: Denotes total time captured from DV tape
- **B** Pause: Pauses DV tape playback
- **C** Current Tape Timecode: Denotes current time position of your DV tape
- **D** Stop: Stops recording file (may also stop DV tape playback)
- **E** Play: Plays DV tape
- **F** Seek: Seeks tape’s timecode
- **G** Rewind: Rewinds DV tape
- **H** Fast Forward: Fast forwards DV tape
- **I** Previous Frame: Goes to DV tape’s previous frame
<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J Shuttle</td>
<td>Shuttles DV tape</td>
</tr>
<tr>
<td>K Next Frame</td>
<td>Goes to DV tape’s next frame</td>
</tr>
<tr>
<td>L Record</td>
<td>Records/captures DV tape content</td>
</tr>
<tr>
<td>M Non Real-time/Real-time Capture</td>
<td>Captures in non real-time (default) or real-time</td>
</tr>
<tr>
<td>N Instant/Batch Capture Modes</td>
<td>Switches from Instant Capturing to Batch Capturing and vice-versa</td>
</tr>
<tr>
<td>O Snapshot</td>
<td>Takes an instant snapshot</td>
</tr>
</tbody>
</table>
A Visual Overview

DV Batch Capture Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Mark In</td>
</tr>
<tr>
<td>B</td>
<td>Current Tape Timecode</td>
</tr>
<tr>
<td>C</td>
<td>Stop</td>
</tr>
<tr>
<td>D</td>
<td>Seek</td>
</tr>
<tr>
<td>E</td>
<td>Rewind</td>
</tr>
<tr>
<td>F</td>
<td>Fast Forward</td>
</tr>
<tr>
<td>G</td>
<td>Mark Out</td>
</tr>
<tr>
<td>H</td>
<td>Shuttle</td>
</tr>
<tr>
<td>I</td>
<td>Non Real-time/Real-time Capture</td>
</tr>
</tbody>
</table>
**Chapter 2**

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J</td>
<td>Instant/Batch Capture Modes</td>
</tr>
<tr>
<td>K</td>
<td>Add Task</td>
</tr>
<tr>
<td>L</td>
<td>Remove Task</td>
</tr>
<tr>
<td>M</td>
<td>Start Selected Task(s)</td>
</tr>
</tbody>
</table>
Trim Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Mark In</td>
<td>Marks in for beginning of trimmed clip</td>
</tr>
<tr>
<td>B Time Slider Position</td>
<td>Denotes current time slider position</td>
</tr>
<tr>
<td>C Mark Out</td>
<td>Marks out for end of trimmed clip</td>
</tr>
<tr>
<td>D Total Time</td>
<td>Total time of trimmed clip</td>
</tr>
<tr>
<td>E Split Video</td>
<td>Splits current clip into two at the time slider position</td>
</tr>
<tr>
<td>F Reset Mark In</td>
<td>Resets mark in position</td>
</tr>
<tr>
<td>G Revert</td>
<td>Reverts to clip’s original trim effects</td>
</tr>
<tr>
<td>H Reset Mark Out</td>
<td>Resets mark out position</td>
</tr>
<tr>
<td>I Snapshot</td>
<td>Takes snapshot</td>
</tr>
</tbody>
</table>
## Chapter 2

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J</td>
<td>Clear</td>
</tr>
<tr>
<td></td>
<td>Clears all trim effects</td>
</tr>
</tbody>
</table>
Speed Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Decrease Speed</td>
</tr>
<tr>
<td></td>
<td>Decreases speed of video</td>
</tr>
<tr>
<td>B</td>
<td>Revert</td>
</tr>
<tr>
<td></td>
<td>Reverts to clip’s original</td>
</tr>
<tr>
<td></td>
<td>speed effects</td>
</tr>
<tr>
<td>C</td>
<td>Clear</td>
</tr>
<tr>
<td></td>
<td>Clears all speed effects</td>
</tr>
<tr>
<td>D</td>
<td>Increase Speed</td>
</tr>
<tr>
<td></td>
<td>Increases speed of video</td>
</tr>
</tbody>
</table>
# Chapter 2

## Titles Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Mark In Marks in for beginning of title effect</td>
</tr>
<tr>
<td>B</td>
<td>Mark Out Marks out for end of title effect</td>
</tr>
<tr>
<td>C</td>
<td>Add Title Adds new title to clip</td>
</tr>
<tr>
<td>D</td>
<td>Revert Reverts to clip’s original title effects</td>
</tr>
<tr>
<td>E</td>
<td>Remove Title Removes title from clip</td>
</tr>
<tr>
<td>F</td>
<td>Set Font Sets font options</td>
</tr>
<tr>
<td>G</td>
<td>Clear Clears all title effects</td>
</tr>
</tbody>
</table>
## Effects Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Revert</td>
</tr>
<tr>
<td>B</td>
<td>Clear</td>
</tr>
</tbody>
</table>

A Visual Overview
## Picture-in-Picture Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Revert</td>
</tr>
<tr>
<td>B</td>
<td>Eyedropper</td>
</tr>
<tr>
<td>C</td>
<td>Clear</td>
</tr>
</tbody>
</table>
# Audio Mode

![Audio Mode Diagram](image)

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Volume Mixing Drag slider for mixing volume for user-defined audio files</td>
</tr>
<tr>
<td>B</td>
<td>Add Audio   Adds new audio file to clip</td>
</tr>
<tr>
<td>C</td>
<td>Revert      Reverts to clip’s original audio effects</td>
</tr>
<tr>
<td>D</td>
<td>Remove Audio Removes audio file from clip</td>
</tr>
<tr>
<td>E</td>
<td>Trim Audio  Trims audio file</td>
</tr>
<tr>
<td>F</td>
<td>Clear       Clears all audio effects</td>
</tr>
</tbody>
</table>
## Transitions Mode

<table>
<thead>
<tr>
<th>Button/Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Decrease Transition Length</td>
</tr>
<tr>
<td>B</td>
<td>Revert</td>
</tr>
<tr>
<td>C</td>
<td>Increase Transition Length</td>
</tr>
<tr>
<td>D</td>
<td>Clear</td>
</tr>
</tbody>
</table>

- **A**: Decrease Transition Length
- **B**: Revert
- **C**: Increase Transition Length
- **D**: Clear
CHAPTER 3:
THE BASICS

It’s time to get started with the basics before your mesmeric and uninhibited effects are added. The ensuing sections will outline how to begin by importing your media files into the PowerDirector Library and previewing these files. Later, you will get accustomed to the Storyboard, your menus and then wrap things up with choosing your specific Preferences.

Importing into the Library

The first step in almost all video editing software applications is to import media files into the software application itself. This area of the software application where the imported files reside is the Library.

1. After you have started the PowerDirector application, click Import Media or choose File > Import > Media Files.

   - Click Import Directory to import all media files in a given directory. Select the folder and click OK.

2. Select the files to be imported by clicking. To select multiple files, press <SHIFT> while clicking to select continuous files or press <CTRL> while clicking to select discontinuous files.

3. Click Open. The file(s) will now be imported to PowerDirector’s Library.
To Show Video, Audio, Images or All, click the appropriate icon in the top left corner.

The files will appear in the Library. Click Large Icons or click Details to change the view to a text view along with some of its associated file properties.

You may also right-click on a specific file for a menu. Select one of the options to Preview, Apply to Storyboard, Import New File(s) to Library, Remove from Library, View Scenes or Detect Scenes. Please refer to the appropriate sections for more information.

Right-click anywhere in the Library area when no files are selected for another menu. Here, you may change your view, import files, sort, and also choose Up One Level if you are in a scenes subfolder. Refer to "Detecting Scenes" on page 31 for more information.
Previewing your Library Files

Previewing Library files simply plays your original files like any other Media Player.

1  After you have imported your files into the Library, begin previewing by dragging the files into the Preview Window or double-click on them. The mode will instantly switch to Preview.

2  Click Play to begin playing your file if it’s a video or audio clip.
   - You may also skip directly to the Start of the file or to the End.
   - Other common commands are Pause, Stop, Next Frame and Previous Frame. The best way to utilize the Next Frame and Previous Frame commands are during the Pause and Stop modes. However, you may click them during playback, which will then switch into Pause mode.
   - Drag and release the Time Slider to navigate quicker when previewing your file.
   - You may also right-click on the Preview Window for a shortcut menu. Select one of the preview options or Apply to Storyboard.

3  If you are satisfied with your file and don’t require any further manipulation, click Apply and the file will be applied to your Storyboard. Be sure to set your...
preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.
Detecting Scenes

Scene detection automatically creates individual files based on the original file’s scenes allowing users to utilize existing video files to its maximum. Even after you are finished detecting scenes for a certain file, you can further divide its scenes an infinite number of times.

1. After you have imported your files into the Library, select a file and click Detect Scenes and the Detect Scenes window will appear.

2. Drag the Sensitivity slider or click Increase/Decrease Sensitivity. The more sensitive the setting, the more scenes it will detect which will generate more video files.

- For previewing functionality, refer to "Previewing your Library Files" on page 29 and #2 for more information.
- Click Advanced Settings for modification before detecting scenes.
The Detection Method section is for captured video content that has been imported into the Library. Refer to “Capturing Content” on page 45 for information on capturing content from a DV camcorder. Use the default unless you have a DV AVI format file that contains multiple timecodes (i.e. resetting of timecodes are automatically set when you start and stop recording) and you wish to split up your files in this manner, select Detect by changing of timecodes.

**Note:** If you have selected Detect by changing of timecodes, in essence, PowerDirector will not be performing the scene detection feature, for scenes that are detected will rely solely on the DV tape’s changing of timecodes, which is ultimately dependent on the DV tape itself.

- To detect more precisely for video content which contain fades (used to delicately move from scene-to-scene), be sure that Ignore fade ins/outs are checked. Otherwise, erroneous scenes may be detected that will include fades.
- To detect more precisely, be sure that Ignore flashing lights (e.g. camera flash) are checked. Otherwise, erroneous scenes may be detected that will include flashing lights.
- Click OK.
- To split your own scenes, drag the slider to the desired position and click Split. The new scene will be compromised of the video content after the split position. Repeat this procedure to create more scenes. To split from the original video file again, click outside of the scenes and the Preview Window will display the original video file.
- **3** Click Detect.
  - After the original scene detection, you may detect again for an infinite number of times! Simply select a scene, repeat all the steps including selecting a sensitivity setting, and then click Detect again!
  - To remove scenes after detection, select the scene and click Remove or Remove All.

**Note:** When removing scenes, content from the removed scene will be merged into the previous scene automatically.
You may also select a scene and right-click for a menu. Choose **Remove Scene** to remove or **Detect Again from this Scene** to detect additional scenes from this specific scene and generate even more files/scenes!

4. After the scenes are created, click **OK** to return to PowerDirector or click **Cancel**.

- The new scene files will now be displayed in the Library in a subfolder. To return to the Library, click **Up One Level**.

- A small folder icon will be displayed for all Library files that have undergone scene detection and which possess additional scene files. Simply click on the icon to access the scenes subfolder for a specific Library file.
Storyboard Functions

When you produce, you are producing all the clips on your Storyboard. If you don’t have any files applied onto the Storyboard, you can’t produce your movie! Thus, the Storyboard is the most important facet and area of your entire pre-production.

Keep in mind that not all files have to be manipulated, for files may be directly applied or dragged onto the Storyboard immediately after it is imported into your Library. Go to “Importing into the Library” on page 27 for more information.

1 Now that your files have been imported into the Library and have previewed it, you can directly drag the media files into the Storyboard without further manipulation and produce your own movie. A red line will appear so as to convey where the dragged file will be placed.

\[\text{Note: Audio files may not be applied individually onto the Storyboard unless it is for the Master Audio or as an audio supplement to an existing clip.}\]

2 To move multiple clips on the Storyboard, simply hold down the <SHIFT> key while clicking the clips you want to move together. The clips will be highlighted. Now, drag and release onto the new position.

3 To remove clips from the Storyboard, simply click it and drag it out of the Storyboard or press <DELETE> on your keyboard when highlighted. A dialog box will appear for you to confirm your removal. Click Yes.
4 To preview or to manipulate a clip from the Storyboard, select it by double-clicking and it will appear in the Preview window. Go to "Previewing your Library Files" on page 29 for more information.

- You may also right-click on a specific clip in the Storyboard for a menu. Select one of the options that will include cutting, copying or pasting clips on the Storyboard.

<table>
<thead>
<tr>
<th>Select All clips on Storyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut from Storyboard</td>
</tr>
<tr>
<td>Copy from Storyboard</td>
</tr>
<tr>
<td>Erase from Storyboard</td>
</tr>
<tr>
<td>Remove from Storyboard</td>
</tr>
</tbody>
</table>

- Click anywhere other than a clip on the Storyboard and a more diverse menu will be displayed that will include Storyboard display and also Go to options. Select one.

<table>
<thead>
<tr>
<th>Select All clips on Storyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut from Storyboard</td>
</tr>
<tr>
<td>Copy from Storyboard</td>
</tr>
<tr>
<td>Erase from Storyboard</td>
</tr>
<tr>
<td>Remove from Storyboard</td>
</tr>
<tr>
<td>Go to the First Clip</td>
</tr>
<tr>
<td>Go to the Last Clip</td>
</tr>
<tr>
<td>Show Clip Length</td>
</tr>
<tr>
<td>Show Clip Info</td>
</tr>
</tbody>
</table>

5 Click **Play Movie** to view clips on your Storyboard before producing. You may select your options under Edit > Preferences > Preview. Go to "Preferences" on page 39 for more information. Or, you may right-click on the Play Movie icon to call up a shortcut menu that will allow you to set the window size during your movie playback.

<table>
<thead>
<tr>
<th>Play Movie</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play in Original Size</td>
</tr>
<tr>
<td>Play 24 fps</td>
</tr>
<tr>
<td>Play in Full Screen</td>
</tr>
</tbody>
</table>

**Note:** Playing the movie is not the final step in your movie-making process and is only a preview of your production. Remember to produce your movie!

- During the movie playback, press <ESC> on your keyboard to quit or double-click.

- Two other icons are located on the Storyboard. For more information on **Master Watermark** or **Master Audio**, go to "Master Watermark" on page 86 and "Master Audio" on page 82 for more information.

6 If you are satisfied with all your clips and your movie, click **Produce Movie** on the Modes Wheel. Refer to "Producing Your Movie" on page 87.
Menu Selections

Below are brief descriptions of various functions. For more information, please follow their links.

File Menu

- If you want to create a new project, choose New. Choose Open to open an existing project.
- Save your project here or choose Save As... to rename the project. Type in the project’s name and click OK.
- The Capture commands are the same as the Modes Wheel but goes directly into one of the three capture modes: Audio, Video or DV. Go to "Capturing Content" on page 45 for more information.
- The Import command serves the same function as Import Media in importing media files to your project’s Library. You may also import Media Files From Folder or Files from Another Project. For the latter, select another project and click Open to import another project’s media files. Refer to "Importing into the Library" on page 27 for more details.

Exporting

- Choose File > Export > Produce Movie to produce your movie. Go to "Producing Your Movie" on page 87 for more information.
For the **Write to DV Tape** function, a quick and easy way is to select a DV AVI file directly from the Library and then choose **File > Export > Write to DV Tape** for instant writing. A dialog box appears. Click **Show Preview** to preview when writing and then click **Start**. Click **Close** when complete.

To write multiple files to a DV tape, drag the DV AVI files from the Library to the Storyboard. It is imperative that you do not add any effects and that all Storyboard clips are in DV AVI format.

- Now, with a DV AVI file selected on the Storyboard, choose **File > Export > Write to DV Tape**. The Storyboard order will be the sequence in which they will be written to DV tape.

- Click **Show Preview** to preview when writing and then click **Start**. Click **Close** when complete. For more information on writing to DV tape when producing, please refer to “Producing AVI Files” on page 99 for more information.

**Project Properties** is for adding more information for your movie. You might want to fill out **Keyword**, which is suitable for database searches, or any other fields.

- Choose **Recent Files...** to select a project you had recently been modifying.
- Choose **Exit** to close PowerDirector.

**Edit Menu**

- The first four commands are if a clip is selected from the Storyboard: **Cut**, **Copy**, **Paste** or **Delete**.

- Select a file from the Library and choose **Remove from Library**. This file will only be removed from this project’s Library.

- For **Preferences**, go to “Preferences” on page 39.

**Modes Menu**

- Select a clip and then any one of the Modes. Go to the individual sections for more details on specific Modes.
Chapter 3

Storyboard Menu

- Before playing your movie, you may set the size you want to play it in. After you set it, and before your final production, you might want to play your movie first.

- Select the Go to functions to navigate faster to the first and last clips on your Storyboard.

- Select Master Watermark to add a watermark or Master Audio to add an audio file for your movie. Go to “Master Watermark” on page 86 and “Master Audio” on page 82 for more information.

Help Menu

- Here you will find any help you might need that will include Content, Search..., and Index...

- You may also Register, Upgrade, and go to i-Power for resources or CyberLink’s home web site.
Preferences

When using PowerDirector, we give you the luxury of deciding the processes and routines of how files are applied to the Storyboard, how captured files are stored, the display of file information, previewing options and a host of others. Preferences are accessed through Edit > Preferences.

General Preferences

- The first option here is for users to select a default media Directory for all their files. Type in the directory path or click Browse and search for the directory. Click OK after you select the proper directory.

- For the Applying Clip Preferences section, select one of the options. The first option is the fastest method and saves time from clicking Apply. The second option forces users to always click Apply after they make changes if they want to
apply. The last option is if you would like PowerDirector to remind you if you would like to apply the changes that you have just made.

- You may decide the number of recent files to be displayed under File > Recent Files... in the **Recent Files** section. Click on the drop-down menu and select the number of recent files to be displayed. Click **Clear List** to clear all the recent files. Select **Automatically load the most recent project** to save time whenever you start PowerDirector.

Click **OK** or another tab to set more preferences.

**Display Preferences**

- The **Library Tool Tips Display** determines how all your media files’ tool tips are displayed in the Library. Check and uncheck the selections to show or hide the desired information.

- The **Storyboard Display** is the next section. Check and uncheck to **Show accumulated time up to current position** if you would like to see a running total for your entire movie. The last selection is to choose either **Show file name** or **Show time length of clip**. You may not choose both.

Click **OK** or another tab to set more preferences.
Capture Preferences

- The first selection is **Autosave**. Choose a directory by clicking **Browse** and selecting a proper directory to save all your captured files under. If you want PowerDirector to **Automatically generate file names under this directory**, click it and captured files will automatically be saved. Otherwise, after each capture, a dialog box will appear for you to name the new captured file.

- The next selection is for snapshots that you have captured from your video content in the Capture or Trim Modes.
  - **Snap to Clipboard** captures the image onto your Windows' clipboard.
  - **Snap to Wallpaper (Center)** will capture the image, place the image centered on your desktop in its original size, and save it automatically in your default Windows' System folder.
  - **Snap to Wallpaper (Tile)** will capture the image, place the image on your desktop in its original size following a tile format, and save it automatically in your default Windows' System folder.
  - **Snap to File** will capture the image directly into a folder you have selected. For this selection, you may input the file name by clicking on **Browse** and choosing a directory first. After you have found the directory and inputted a name, click **Save**. Change the file format by clicking on the drop-down menu and selecting.

- The next section is the **Capture Destination**. Check the selections if you would like to automatically add the recently captured files to the Library, Storyboard, or both.
For **Capture Performance**, if you want your VGA card to regulate the video overlay so less CPU resources are consumed, speed is faster, but less stable than non-overlay mode in some cases (depending on your VGA card), click **Use video overlay**.

In the **DV Parameter Setup** section, click **Setup...** to set up the buffer parameters for your DV camcorder.

- All DV camcorders’ mechanisms and the time it takes for the tape to start rolling differ in seconds. Thus, if there is no buffer time, batch capturing will begin too early. Enter the time you would like to buffer your DV tape so that batch capturing will coincide with it. The tape will begin playing during this buffer time and after it has elapsed, capturing takes place.

- When writing to tape, all DV camcorders’ mechanisms and the time it takes for the tape to start rolling differ in seconds. Setting an adequate buffer time for sending video stream to your tape eliminates these differences so that when the tape begins writing, it coincides with the beginning of the video stream feed. Click **OK**.
Preview Preferences

- To set the **Window Size** for your Preview Window, click on the drop-down menu and select.

- When you are editing clips from the Storyboard, you may decide to reserve system resources by ignoring video effects or audio tracks during previewing or in when modifying in any of the Modes. In the **Clip Previewing** area, simply click to select which option you want to ignore. Be sure to check out “System Requirements” on page 5.

- Whenever you click Play Movie on the Storyboard, you may wish to **Play from selected clip** or **Play from first clip**. Select one.

- During the actual **Production Process**, you may choose which type of display is utilized. The **Don’t display preview** selection saves the most system resources. For the **Display a quick video preview**, not every frame will be displayed. Check **Display the full video preview in real-time** if you want to watch the entire movie’s preview.

**Note:** *There is no audio during the Production Process.*

Click **OK** to exit Preferences.
PowerDirector allows you to capture almost anything under the sun provided that you have a capture card or other assortment of adapter cards in transferring data into your hard drive. Listed below are video capture devices that may assist you in making the best possible movie out there:

- capture card (PCI, USB, FireWire or other FireWire formats)
- DV camcorder or DV VCR
- analog camcorder or VCR in 8mm, Hi8, VHS, VHS-C, Beta format
- digital camera
- PC camera

Just make sure you have all the proper hardware and drivers installed before you begin.
Capturing Video and Audio

Now you are ready to capture video or audio footage from practically anything digital or analog stored in your library and transforming it into digital footage with special effects directly authored from PowerDirector.

This section will cover video capture devices that are input through your adapter cards via video ports such as Composite video, S-Video or Tuner and also audio capture devices through ports such as Audio In or from your audio CD. However, this section won’t include capturing from a DV camcorder. Please refer to “Capturing from DV Camcorders” on page 50 for more information.

Make sure your devices are installed properly with the proper drivers. Refer to their respective user’s guide for more information.

1. Start PowerDirector. Click the **Capture Mode** located on the Modes Wheel.
2. Depending on the content you would like to capture (audio or video), click the appropriate Capture icon, either **Video Capture** or **Audio Capture**.

- If you clicked **Video Capture**, click **Video Setup** to modify. A dialog box will appear.

![Video Setup dialog box](image)

![Capture Mode](image)
- Click on the **Capture Device** drop-down menu to select the appropriate video capture device installed on your system.

- Select the correct **Capture Source**. Usually, all the sources will have ports located on the capture card. Make sure the connections are secure.

- If you selected **Video Tuner**, you may then select either **CATV** (if you have a cable connected) or **Antenna** installed. Select a channel and click **OK**.

![Capture Setup](image)

- While in the Video Capture mode, select a **Profile Setup** by clicking on it. When the dialog box appears, select which purpose this video is for. If it’s for **Video for General Purposes**, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose. Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats, refer to #4 in "Producing AVI Files".

![Profile Setup](image)

- If you selected a MPEG profile, you may create a custom MPEG profile by clicking **New**... Refer to "Creating Custom MPEG Profiles" on page 94 for more information. If you selected an AVI profile and want to change its settings, click **Settings**... and then refer to "Setting AVI Profiles" on page 102 for more information.

- If you selected **Video for Movie Disc Production**, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.
After selecting a profile, you may click **Comments...** or **Details...** to find out more information about the profile and CPU recommendation.

- Click **OK** when you are finished with the Video Setup.

**Note:** If the video display is blank after you have selected to capture video, be sure your video device is functioning properly. Other possibilities may be that the connections aren’t set up properly or you selected the wrong input settings.

- Now, modify the **Audio Setup** if you are capturing audio by clicking on it either in Video or Audio Capture mode. A dialog box will appear.

  - Click on the **Audio Device** drop-down menu to select the appropriate audio capture device installed on your system.
  - For the **Audio Input**, select the right input source (selections here will depend on your sound card manufacturer). Click **OK**.
  - If you have an audio CD, select the **Audio CD** selection for the Audio Input and an additional drop-down menu will appear to select the audio track that you would like to capture/rip.
  - You may select **Rip selected CD track at highest speed** in order to rip the selected track into your HDD into WAV format. Click **OK**.
  - To alter the audio capture profile, switch to the Audio Capture mode and then click **Profile Setup**. A dialog box will appear.
Click a **Name** (i.e. profile) or change your **Attributes** by clicking on the drop-down menu and choosing another one.

Click **Save As** to save the new profile. Name the new profile and click **OK**. To Remove, select a profile and click **Remove**. After you are done, click **OK**.

Click the **Time Limit** box to set it and then input the maximum recording time in minutes and seconds.

Click the **Size Limit** box to set it and then input the maximum recording size in MB.

If you are in the Video Capture mode, you may click **Snapshot** to capture still images from your video content. To set your preferences, go to “Capture Preferences” on page 41 for more information.

Depending on your device, turn it on, press Play or activate any other function so that your external capture device will begin capturing or playing content that PowerDirector is able to record. When ready, click PowerDirector’s **Record** button.

**Note:** For example, a PC camera would not have to be activated after its power is turned on, for it will begin capturing content automatically.

**Note:** An audio CD, on the other hand, does not need to be played. Just click Record and PowerDirector will begin playing and recording it.

Click PowerDirector’s **Stop** button after finishing your capture. The file will now be saved automatically, or appear in your Library or Storyboard. Go to “Capture Preferences” on page 41 for more information.
Capturing from DV Camcorders

Whether your DV is playing video or filming special moments, PowerDirector captures it all in non real-time or in real-time.

**Info:** Unlike real-time capture, non real-time capture will utilize a buffer and is recommended for users who desire high quality but do not possess adequate computing power. Thus, non real-time capture will take longer to process the encoding of captured content when utilizing a buffer. A display of the time remaining for capturing will be located at the bottom right corner below the Preview Window.

With real-time capture, the actual content being encoded will coincide with the content that is being played in the Preview Window and consume more CPU resources. This will not hold true for non real-time capture.

And, with the astounding FireWire transfer protocol, you will capture crystal clear digital video and audio from your DV camcorder and transfer data without any quality loss whatsoever.

Capturing from a DV camcorder differs in two respects. As you might well be aware of, DV camcorders come with two main modes. The first mode is to record live content and is referred to as the **Camera** mode for most brands. The alternative mode is the **VCR** mode (for most brands) where you may play back your previously recorded content and navigate through the DV tape. The degree of controlling your DV camcorder with PowerDirector differ in these two DV modes.

**Note:** Before starting PowerDirector, make sure all devices are installed properly with the proper drivers, your DV camcorder is turned on, is in the correct mode, and the FireWire cables are hooked up properly. Refer to the respective user’s guide for more information.

**Capturing from DV Camera Mode**

When your DV camcorder is in the Camera mode, PowerDirector may only **Record** into your hard drive, for it will simply capture what your DV camcorder is aimed at or what it is recording. For other commands in the Camera mode, you will have to rely on your DV camcorder’s controls.

1. Start PowerDirector. Click the **Capture Mode** located on the Modes Wheel.
2. Click the **DV** icon. If you’re DV camcorder is hooked up properly along with the FireWire cables, turned on, and in the **Camera** mode (this will depend
on your DV camcorder’s designation), a live shot from your DV camcorder should be displayed in PowerDirector’s Preview Window.

**Tips:** The bottom left corner will display the amount of free drive space along with the size of the captured content. This drive may be set in Edit > Preferences... > Capture under the Autosave section.

3 Now, decide if you would like to capture in Non Real-time (default) or Real-time (switch on).

**Info:** Unlike real-time capture, non real-time capture will utilize a buffer and is recommended for users who desire high quality but do not possess adequate computing power. Thus, non real-time capture will take longer to process the encoding of captured content when utilizing a buffer. A display of the time remaining for capturing will be located at the bottom right corner below the Preview Window.

With real-time capture, the actual content being encoded will coincide with the content that is being played in the Preview Window and consume more CPU resources. This will not hold true for non real-time capture.

4 Select a Profile Setup by clicking on it. When the dialog box appears, select which purpose this video is for. If it’s for Video for General Purposes, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose. Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats
and the differences between the Windows and DV groups, refer to #4 in "Producing AVI Files".

- If you selected a MPEG profile, you may create a custom MPEG profile by clicking **New...** Refer to "Creating Custom MPEG Profiles" on page 94 for more information. The DV AVI profiles may not be modified.

- If you selected **Video for Movie Disc Production**, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.

- After selecting a profile, you may click **Comments...** or **Details...** to find out more information about the profile and CPU recommendation.

5  Click **OK**.

**Caution:** If you have selected the DV AVI profile, you will be unable to capture in non real-time.

- Click the **Time Limit** box to set it and then input the maximum recording time in minutes and seconds.

- Click the **Size Limit** box to set it and then input the maximum recording size in MB.

6  To begin capturing, click PowerDirector’s **Record** button.

7  Click **Stop** after finishing your capture. The file will now be automatically added to the Library or Storyboard according to your preferences. To set your preferences, go to "Capture Preferences" on page 41.

**Note:** If you have chosen to capture in non real-time, after you have clicked **Stop**, a message will be displayed in the Preview Window notifying you that the encoding of the content in the buffer is still ongoing and that it will be completed shortly in the time remaining.
Capturing from DV VCR Mode

When your DV camcorder is in VCR mode, PowerDirector has a high degree of control. All navigational functionality may be controlled by PowerDirector including playing, seeking, pausing, stopping and of course, recording content directly from the DV tape. After capturing content from your DV tape with PowerDirector, you may apply all the special effects you wish, which have made PowerDirector a powerhouse in the arena of video editing. Finally, when it is time to produce, PowerDirector provides the luxury of writing your new movie directly onto your DV tape! Please refer to "Producing Your Movie" on page 87 for more information on producing.

1. Start PowerDirector. Click the Capture Mode located on the Modes Wheel.

2. Click the DV icon. Make sure you’re DV camcorder is hooked up properly along with the FireWire cables, is turned on, and in the VCR mode (this will depend on your DV camcorder’s designation). The display you are viewing in PowerDirector’s Preview Window should be exactly as your DV camcorder screen.

3. Now, decide if you would like to capture in Non Real-time (default) or Real-time (switch on).

Tips: The bottom left corner will display the amount of free drive space along with the size of the captured content. This drive may be set in Edit > Preferences... > Capture under the Autosave section.
Info: Unlike real-time capture, non real-time capture will utilize a buffer and is recommended for users who desire high quality but do not possess adequate computing power. Thus, non real-time capture will take longer to process the encoding of captured content when utilizing a buffer. A display of the time remaining for capturing will be located at the bottom right corner below the Preview Window.

With real-time capture, the actual content being encoded will coincide with the content that is being played in the Preview Window and consume more CPU resources. This will not hold true for non real-time capture.

4 Select a Profile Setup by clicking on it. When the dialog box appears, select which purpose this video is for. If it's for Video for General Purposes, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose. Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats and the differences between the Windows and DV groups, refer to #4 in "Producing AVI Files".

- If you selected a MPEG profile, you may create a custom MPEG profile by clicking New... Refer to "Creating Custom MPEG Profiles" on page 94 for more information. The DV AVI profiles may not be modified.
- If you selected Video for Movie Disc Production, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.
- After selecting a profile, you may click Comments... or Details... to find out more information about the profile and CPU recommendation.

5 Click OK.

Caution: If have selected the DV AVI profile, you will be unable to capture in non real-time.
To seek to the proper time, drag and release the **Shuttle** icon. Located to its immediate left is the timecode area for the DV tape.

**Note:** If the DV tape’s timecode is incorrect, then click Seek Tape to verify the timecode.

You may also navigate with the **Play**, **Next**, and **Previous Frame** buttons. Refer to #2 in “Previewing your Library Files” on page 29 for more information on the aforementioned commands.

**Caution:** If have selected the DV AVI profile, you will be unable to capture in non real-time.

- Click the **Time Limit** box to set it and then input the maximum recording time in minutes and seconds.
- Click the **Size Limit** box to set it and then input the maximum recording size in MB.

To begin real-time capture, click **Play** on your camcorder and then click PowerDirector’s **Record** button when you’re ready. The total recording time will be displayed above the DV tape’s timecode area.

**Note:** When capturing in non real-time, if your HDD is almost out of space (if less than 150 MB of free space, all capturing will be disabled), a warning message will appear in the Preview Window notifying that a portion of the transcoding process will be paused and resume later only after all the content in the buffer has been encoded by your HDD.

Click **Stop** after finishing your capture. The captured file may appear directly in your Library or Storyboard depending on preferences. Go to “Capture Preferences” on page 41 for more information.

**Note:** If you have chosen to capture in non real-time, after you have clicked Stop, a message will be displayed in the Preview Window notifying you that the encoding of the content in the buffer is still ongoing and that it will be completed shortly in the time remaining.
Chapter 4

Batch Capturing from DV Camcorders

When you are in the DV VCR mode, you may select precise scenes you want to convert. After selecting a few scenes, you may convert them with one click as part of a whole batch of files. Batch capturing is efficient and saves huge amounts of time when capturing numerous scenes.

**Tips:** Be sure that your DV tape’s timecodes are linear. If not, you might have to capture a scene at a time in the DV VCR mode.

1. Start PowerDirector. Click the **Capture Mode** located on the Modes Wheel.
2. Click the **DV** icon. Make sure your DV camcorder is hooked up properly along with the FireWire cables, is turned on, and in the **VCR** mode (this will depend on your DV camcorder’s designation). The display you are viewing in PowerDirector’s Preview Window should be exactly identical to your DV camcorder screen.
3. Click **Batch Capturing**.

**Tips:** The bottom left corner will display the amount of free drive space along with the size of the captured content. This drive may be set in Edit > Preferences... > Capture under the Autosave section.
Now, decide if you would like to capture in **Non Real-time** (default) or **Real-time** (switch on).

*Info:* Unlike real-time capture, non real-time capture will utilize a buffer and is recommended for users who desire high quality but do not possess adequate computing power. Thus, non real-time capture will take longer to process the encoding of captured content when utilizing a buffer. A display of the time remaining for capturing will be located at the bottom right corner below the Preview Window.

With real-time capture, the actual content being encoded will coincide with the content that is being played in the Preview Window and consume more CPU resources. This will not hold true for non real-time capture.

Select a **Profile Setup** by clicking on it. When the dialog box appears, select which purpose this video is for. If it’s for **Video for General Purposes**, click it and then select a MPEG or AVI video format from the drop-down menu. Then, select a profile group depending on the format you chose. Finally, select the profile located in the drop-down menu located on its right. For the MPEG profiles, select High Speed, High Quality, Custom or All. For the AVI formats and the differences between the Windows and DV groups, refer to #4 in "Producing AVI Files".

- If you selected a MPEG profile, you may create a custom MPEG profile by clicking **New**. Refer to "Creating Custom MPEG Profiles" on page 94 for more information. The DV AVI profiles may not be modified.
- If you selected **Video for Movie Disc Production**, select the Type of Disc, High Speed or High Quality, and then the video format of the disc.
- After selecting a profile, you may click **Comments** or **Details** to find out more information about the profile and CPU recommendation.

Click **OK**.
Chapter 4

Caution: If have selected the DV AVI profile, you will be unable to capture in non real-time.

- To shuttle (fast forward/rewind) to the proper time, drag and release the Shuttle icon.
- Click Seek Tape to locate the exact timecode position of the DV tape.

Note: Depending on the specific DV tape, there may be identical timecodes for many different scenes on a DV tape (e.g. 00:01:20). This is attributed to the resetting of timecodes performed by the author. When seeking tape with PowerDirector, it will only seek to the first timecode. If your DV tape has been reset numerous times, it is advised for you to capture in DV VCR mode, for capturing in batch mode highly relies on linear timecodes.

- You may also navigate with the Play, Next and Previous Frame, Rewind, Fast Forward, Pause, and Stop functions of PowerDirector. Refer to "Previewing your Library Files" on page 29 or use your DV camcorder’s navigational buttons.

7 To begin adding tasks, go to the correct time position where you would like to begin batch capturing and click the Add New Task icon. A new batch task will appear in the batch box.

Note: The Mark Out position (“Stop Time”) will automatically be set 5 seconds ahead of the Mark In position (“Start Time”). Be sure to set the correct Mark Out position.

8 Navigate to the end of the segment you would like to convert and click Mark Out.

- To reset the Start Time, navigate to the beginning of the segment and click Mark In.

9 To begin conversion, be sure the specific task(s) is checked first. Click Start Selected Task(s) to begin capturing your batch.

Note: When capturing in non real-time, if your HDD is almost out of space (if less than 150 MB of free space, all capturing will be disabled), a warning message will appear in the Preview Window notifying that a portion of the transcoding process will be paused and resume later only after all the content in the buffer has been encoded by your HDD.

10 Click Stop to abort batch capturing.

Note: If you have chosen to capture in non real-time, after you have clicked Stop, a message will be displayed in the Preview Window notifying you that the encoding of the content in the buffer is still ongoing and that it will be completed shortly in the time remaining.
Repeat the above steps to add more tasks.

To remove tasks, select one and click Remove Task.

After it is completed, the batch captured files may appear directly in your Library or Storyboard depending on preferences. Go to “Capture Preferences” on page 41 for more information.
CHAPTER 5: TRIMMING VIDEO

Trim Mode

Generally, after your media files are imported into your library, the next step is to trim your video clips or set the time limit for image files. Before production, this step is very important in eliminating unwanted portions of your video clip and to place more focus on the essential plot of your movie.

**Note:** After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

**Note:** Your original media files will not be manipulated in any way when trimming files that have been imported into the Library or after it is applied to the Storyboard.

1. Select a media file from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 27 for more information on importing.

2. To trim files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3. Click the Trim Mode located on the Modes Wheel.

**Note:** Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to "Preferences" on page 39 for more information.

4. Before setting your trim positions, you may play your file. Go to "Previewing your Library Files" on page 29 for more information on navigation during playback.
Chapter 5

- Drag and release the Time Slider to find the exact time positions and quicken your search. You may also Play, Rewind, Fast Forward, Pause, jump to the Start or End of the file, and go to the Next or Previous Frame.

- To capture the frame as a new image file, click Snapshot. Go to “Capture Preferences” on page 41 for more information.

5 Click on the Mark In and Mark Out icons to set your trimming positions at the Time Slider position or set them during playback. Or, you may also utilize the Time Slider and directly drag the Mark In and Mark Out sliders to the position where you would like to begin your trim.

- After your Mark In and Mark Out positions have been set, their times will be displayed to the right of each respective icon along with the time length for this new clip in the bottom right area. The other time slot on the bottom left indicates the current position of the Time Slider.

- To reset, click Reset Mark In or Reset Mark Out.

- To Resize your view, select one of the options from the drop-down menu.
  - Stretch: This option will stretch your media file to fill out the screen but will not keep the aspect ratio.
  - Crop: This keeps the aspect ratio of your media file and if larger than the Preview Window, it will crop off the sides.
  - 1:1 Fit: This will fit your media file into the Preview Window but unlike Stretch, it will keep the aspect ratio of the media file and won’t crop the image.
  - 1:1 Fill: This will fill out the Preview Window with the original size but will crop the image.

Note: The resize function will not alter your original file but will affect your Storyboard clip.

- Click Revert to return to the original trim (if the clip had already been trimmed) or click Clear to start from scratch.

6 When you are satisfied with your trim, click Apply and your trim will be applied to your Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.
Splitting the Video File

To save precious editing time, the Split Video function automatically splits an original video file into two separate clips with one swift click and eliminates the need to drag the same file onto the Storyboard twice and trimming both separately. Just keep in mind this function is only intended for Library files that do not have effects applied from other modes. Apply effects only after you split the video.

1. Select a media file from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 27 for more information on importing.

2. To split video files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

Note: If the Storyboard clip has been previously modified or contain effects, this clip may not be split.

3. Click the Trim Mode located on the Modes Wheel.

4. Drag the Time Slider to the scene where you would like to split this video or through any other navigational method.

5. Click Split Video. The file will be split into two clips on the Storyboard.

   If you would like to further trim either clip, refer to "Trim Mode" on page 61.
Chapter 5

Trim Mode for Image Files

Naturally, image files don’t need to be trimmed. The time duration of the appearance of the image file may be set along with the image’s resize if desired.

1. Once your image files have been imported into the Library, double-click on an image file or drag it in order to display it in the Preview Window. Refer to “Importing into the Library” on page 27 for more information on importing.

2. To modify files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3. Click on the Trim Mode from the Modes Wheel.

- To Resize, select one of the options from the drop-down menu.
  - **Stretch**: This option will stretch your media file to fill out the screen but will not keep the aspect ratio.
  - **Crop**: This keeps the aspect ratio of your media file and if larger than the Preview Window, it will crop off the sides.
  - **1:1 Fit**: This will fit your media file into the Preview Window but unlike Stretch, it will keep the aspect ratio of the media file and won’t crop the image.
- **1:1 Fill**: This will fill out the Preview Window with the original size but will crop the image.

4. Enter the time for the image to appear in the **Duration** box by using the arrows or inputting a numeral.

- Click **Revert** to revert to the original trim.

- Or click **Clear** to start over.

5. Click **Apply** when complete. Be sure to set your preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.
CHAPTER 6:
ALTERING SPEED
AND SUPPLYING
VIDEO EFFECTS

Altering Speeds

To invigorate your audience and enliven your movies with a different pace or tempo, or to emphasize certain elements of meaningful clips, PowerDirector allows you to go slo-mo or accelerate clips to previously unforeseen speeds! Any clip could be slowed down to a crawl or sped up to the speed of light. As a director, utilize both these mind-altering speed effects to throw your audience for a loop, because as any sane person or scientist will protest to, time is relative to the observer except in the warped parallel universe of PowerDirector.

1 Select a video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 27 for more information on importing.

2 To add effects to files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3 Click Speed Mode on the Modes Wheel.

4 Drag the slider in order to slow or quicken up the video speed. You may also click Increase Speed or Decrease Speed with the range being 1/4X - 8X.
Now, you must decide how your video file’s audio will be played. Click on the Audio Setting drop-down menu and select one.

- The Synchronize with video selection will synchronize the video speed with the audio speed.

**Note:** If the video speed is faster or slower than 1X, the synchronized audio may be unrecognizable.

- Select Preserve original speed if you prefer the audio speed to be at its original recognizable speed independent of the video speed.
- Select Mute to mute this video file’s audio. This is great for dubbing over original audio content with another audio file or background music.
- Click Revert to return to the previous state or click Clear to start from scratch.

After you are satisfied with your alteration, click Apply to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to ‘Preferences’ on page 39 for more information.
Supplying Video Effects

Supplying video effects is for the music video director in you! For normal movies, transition effects are sufficient, but for those who wish to cast a spell and enrapture the audience with a video effect that takes hold throughout the length of one clip, this is your epiphanous calling.

Let’s first enjoy a graphical display of all the effects:

Below is a table that summarizes the settings available for each video effect.

<table>
<thead>
<tr>
<th>Video Effects</th>
<th>Settings Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Brightness, Contrast, Hue, Saturation, Sharpness</td>
</tr>
<tr>
<td>Blur</td>
<td>Degree</td>
</tr>
<tr>
<td>Color Focus</td>
<td>Depth of Gradient Border, Width of Color Area, Height of Color Area</td>
</tr>
<tr>
<td>Delay</td>
<td>Regularity</td>
</tr>
<tr>
<td>Edge</td>
<td>Degree, Background Color, Foreground Color</td>
</tr>
<tr>
<td>Emboss</td>
<td>Direction</td>
</tr>
<tr>
<td>Focus</td>
<td>Depth of Gradient Border, Width of Original Image, Height of Original Image, Background Color</td>
</tr>
</tbody>
</table>
1 Select a video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 27 for more information on importing.

2 To add effects to files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3 Click **Effects Mode** on the Modes Wheel.
4 Drag an effect from the Library over to the Preview Window or double-click the effect. Depending on the effect, settings will vary.

- For most effects settings, simply drag the slider and then preview it in the Preview Window before applying. Refer to "Previewing your Library Files" on page 29 and #2 for more information.

- For some effects settings, you may drag the **Effect Length**'s slider to determine the length of time for the effect. By decreasing the effect’s length (represented by the two orange bars), the **Hold Time** (i.e. the applied video effect represented by the blue bar), will be increased and vice-versa.

- For some effects settings, you will notice a **Link Settings** function that links two given settings and constrains the proportion of a video effect such as for the Grid and TV Wall effects. To unlink these settings, click on it.

- For some effects settings, you may choose a **Foreground** or **Background Color**. Click on either and then select the color. Click **OK**.

- Click **Revert** to return to the previous state or click **Clear** to start from scratch.

5 After you are satisfied with your effects, click **Apply** to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.
CHAPTER 7:
ADDING TITLES AND TRANSITIONS

Titles Mode

Generally, at the beginning of every movie or show, text is involved to convey the title, starring and supporting actors, and other information for all those involved and whom made the movie possible. When a movie or show wraps up, the full spate of credits will be rolled out too.

For smaller movie productions, you may want to inform viewers with textual effects instead of just visual effects. So, get ready to begin communicating literally like you never have before.

*Note: After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.*

1. Select a video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to "Importing into the Library" on page 27 for more information on importing.

2. To add titles to files that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3. Click Titles Mode ⚪️ on the Modes Wheel.

*Note: Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to "Preferences" on page 39 for more information.*
Click the Fonts icon to set your font format. There are a host of options here including Spacing, Color, Font Style, and Alignment. After you are finished, click OK.

4 Click on the Add Title icon. A cursor on the first line of the Titles box will appear for you to begin typing. Press <Enter> to skip to the next line if you wish.

5 After inputting your text, click outside of the box. The title will be displayed in the Titles box along with the Preview Window.
6. To select a suitable **Title Effect**, select a title first and then click on the drop-down menu to select. An instant preview will be shown in the Preview Window.

- Drag the **Effect Length**’s slider to determine the length of time for the effect. By decreasing the effect’s length (represented by the two orange bars), the **Hold Time** (i.e. only the text without effects represented by the blue bar), will be increased and vice-versa.

**Note:** Each chosen title effect vary in terms of duration length.

- To minimize the duration of an entire title effect (i.e. you don’t want the title effect to last the entire duration of the clip), click and drag the Effect sliders, located on the periphery and above the orange bars, towards the center. Or, position the Time Slider at a designated point and then click **Mark In** or **Mark Out** below the Preview Window.

**Tips:** In order to increase the Hold Time (blue bar) and decrease the Effect Length (orange bars), position the Time Slider and set the Mark In and Mark Out positions extremely close. Then, increase the Effect Length by clicking and dragging the Effect sliders.

7. To place a title at a certain area of the screen, simply click on it in the Preview Window and drag.

- Click **Revert** to return to the original titles and their associated effects or click **Clear** to start from scratch.
- Repeat the above steps to add more titles.
Chapter 7

- To edit or removing titles, click on a title in the Titles box. To edit, click twice and a cursor will appear in the box. Begin editing.
- To remove, select an existing title and then click Remove Title.
- You may hide titles by unchecking Show All Titles or checking to show all.

After you are satisfied with all your titles, click Apply to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.
Adding Titles and Transitions

Transitions Mode

Usually appearing naked to the human eye, transitions are a great mood enhancer in movies or full-length feature shows and videos. Generally, scene-from-scene, simple fades or a direct cut to the next scene is used. To further enhance your video, you may want to try one of the many transitional effects PowerDirector has provided.

Before you begin, be sure that there are at least two video clips or images that have been applied in the Storyboard.

Note: After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

1. Click a transition icon located anywhere between two clips from the Storyboard.

2. Or, you may select a clip from the Storyboard and then click Transitions Mode on the Modes Wheel.

Note: Transitions may not be applied to the last clip on the Storyboard.

3. To preview a transitional effect before you apply, place your cursor above a given transition in the Library.

Select a transition by clicking on it twice or dragging to the appropriate point between the selected clip and the clip immediately proceeding it on the Storyboard. You may also drag the transition from the Library to the Modes Panel. The chosen transition will now appear in the Modes Panel.
4 Input the **Transition Length** located in the Modes Panel numerically or drag the slider to increase and decrease. The length will vary depending on your clips’ duration.

*Note:* Keep in mind that the length you set will be equally divided amongst the two slides. If you set ten seconds, five seconds of the transitional effect will be allotted to the end of the first media file while five seconds will be allotted to the beginning of the succeeding media file.

**Tips:** Don’t forget that many of the transitional effects are so radical, that they will literally “swallow” up some of your clip’s content. Consequently, be sure that your clips have ample time in the beginning and in the end so as not to interfere with your clip’s content and that the transition length is not set too long.

- Click **Revert** to revert to the original transition effect or click **Clear** to clear all transitions.

5 When you are finished with your selection, click **Apply** to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to “Preferences” on page 39 for more information.
CHAPTER 8: ADDING AUDIO AND PICTURES

Audio Mode

As all amateur or seasoned video professionals know, the soundtrack of your movie is incredibly important to set the mood and atmosphere of your movie. For exciting scenes, a musical score with a fast beat will serve to outline the hastiness and recklessness of the occasion. For tender moments, a beautifully scored song touching on romance and playing with your emotions like a concert violinist will go a long way in making your post-production a worthy undertaking.

Note: After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

1 Select a file from the Library by double-clicking on the selected file or dragging it into the Preview Window. Refer to “Importing into the Library” on page 27 for more information on importing.

2 To add audio to clips that have already been applied to the Storyboard, simply select the particular clip by double-clicking and it will be displayed in the Preview Window.

3 Click Audio Mode on the Modes Wheel.

Note: Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to “Preferences” on page 39 for more information.

4 If your original file or clip contains audio, it will be displayed in the uppermost line.
5. To add more audio files to a certain clip, drag them from the Library into the User-Defined box or you may click the Add Audio icon. A flashing message will appear in the User-Defined box to show you where you should drag the audio file to. Four user-defined audio files are allowed, which will be displayed below the original file.

6. To trim the audio, select a particular file and click Trim Audio.

7. Trimming controls are very similar to trimming other media files. Please refer to #5 in "Trim Mode" on page 61 for more information. Click Apply and then OK when you are finished trimming your audio clip.

- If you want the audio clip to Fade In or Fade Out, click the corresponding option.
- Adjust the volume by dragging on the Volume Mixing to increase or decrease after you have selected the audio file. Drag to the farthest left to mute it. Keep in mind that this volume will be combined with the original clip’s audio volume (if applicable).
- Select an audio clip (not including the original) and click Repeat Selected Audio File so that the audio file will repeat to the end of the video clip or the end of the image file’s duration.
If you want to remove a file, click an audio file and then click **Remove Audio**.

Click **Revert** to return to the original clip’s audio effects (if the clip had employed audio clips previously) or click **Clear** to start from scratch.

Click **Apply** when you are finished to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.
Chapter 8

Master Audio

To further accentuate the audio aspect of your movie production, you may wish to apply a musical score that will act as the background audio for your entire movie. The controls and options for the master audio file is very similar to the normal Audio Mode where you add files to various clips.

Caution: If you utilize Master Audio in your movie, SVRT will be disabled when producing.

1. Click Master Audio located on the Storyboard’s farthest left. The entire Storyboard will be highlighted.

2. The Master Audio controls will be displayed below the Modes Wheel in the Modes Panel. Drag an audio file from the Library into the designated box.

3. Click Trim Audio to begin trimming your Master Audio file. Trimming controls are very similar to trimming other media files. Please refer to #5 in Trim Mode for more information. Click Apply and then OK when you are finished trimming your audio clip.

   - If you want the audio clip to Fade In or Fade Out, click the corresponding option.
Adjust the volume by dragging on the Volume Mixing to increase or decrease after you have selected the audio file.

To Repeat Master Audio, click to check the box so that it will repeat until the end of the entire movie.

Click Revert to return to the original Master Audio file or click Clear to start from scratch.

You do not need to click Apply in this mode. Just switch out of the mode and your Master Audio will be set and save your project.
Chapter 8

Picture-in-Picture Mode

For any of your existing video clips or image clips on the Storyboard, you may add a still image or video to the background. Set the transparency level depending on your preferences.

**Note:** After you have modified your file in this mode, a red line will be displayed in the Modes Wheel to indicate this.

1. First, select the default picture or video clip from the Library by double-clicking on the selected file or dragging it into the Preview Window. The file will be displayed. Refer to “Importing into the Library” on page 27 for more information on importing.

2. Or, you may select a clip that has already been applied to the Storyboard by simply selecting the particular clip and it will be displayed in the Preview Window.

3. Click the **Picture-in-Picture (PiP)** Mode located on the Modes Wheel.

**Note:** Whenever the mode switches from Preview to another mode for the first time, a dialog box may appear to notify you that the file will be added to the Storyboard automatically depending on your Preferences. Refer to “Preferences” on page 39 for more information.

4. A message will flash in the Preview Window. Select the second “picture” from the Library in the form of an image or video file by dragging it there.

**Note:** If you already have a PiP file applied to the original clip, a dialog box will appear to ask you in replacing your original file after you have dragged the new file to the Preview Window. Click OK.
Adding Audio and Pictures

- Click and drag the points located on the edge of the file to enlarge or decrease its size. Keep in mind that the **Keep Aspect Ratio** is checked as the default. If you do not want to retain its width-to-length size ratio intact, uncheck it.
- Drag the **Transparency** slider to make the picture more or less transparent.
- Click **Revert** to return to the original clip’s PiP file and its associated modifications or click **Clear** or press <DEL> on your keyboard to start from scratch.

5. Click **Apply** when you are finished to apply it to the Storyboard. Be sure to set your preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.

Applying Image Color Filters

Only for image files in the PiP Mode, you may want to apply a color filter so that a specific color of the image file will blend the background of the image with the foreground of the original file. This is not applicable for video files.

1. With the image file selected in the PiP Mode, click **Eyedropper** to apply the color filter.

2. A dialog box will appear. Now, position the **Eyedropper** tool over the color you want to filter out and then click once to select it. The color box on the left displays the current color the Eyedropper is positioned over. The right box displays the color that was last filtered. Click **OK**.

3. Now, check **Apply Color Filter** by clicking in the box. To disable this function, uncheck by clicking it again.

4. Click **Apply** when you are finished. Be sure to set your preferences for applying to the Storyboard. Go to "Preferences" on page 39 for more information.
Chapter 8

Master Watermark

There are times when you wish to add an image that will serve as a visual background throughout the movie, which will usually represent the party that has created the movie or owns the rights to it. This is a watermark. It may also be a TV station logo or the movie title.

**Caution:** If you utilize Master Watermark in your movie, SVRT will be disabled when producing.

1. Click **Master Watermark** located on the Storyboard’s left side. The entire Storyboard will be highlighted.

2. The steps here are extremely similar to the PiP Mode except that only an image file may be used. Go to #4 in "Picture-in-Picture Mode" on page 84 for the rest of the steps.

3. You do not need to click Apply in this mode. Just switch out of the mode and your Master Watermark will be set and save your project.

**To Apply Color Filter,** go to "Applying Image Color Filters" on page 85 for more information.
CHAPTER 9:
PRODUCING YOUR MOVIE

The time has finally arrived for you to produce your own movie. After all your hard work of importing media files into your Library, previewing them, manipulating them, and applying them to the Storyboard, the production of your grand masterpiece is imminent. This chapter will cover MPEG-1, MPEG-2, Windows Media and AVI formatted video types.

Editing and producing MPEG and DV AVI files and clips is what makes PowerDirector a powerhouse in video editing software applications.


Many video editing software applications waste valuable time when decompressing MPEG and DV AVI files into uncompressed AVI format before the editing process. During editing, this process places unnecessary burden on your hard disk by requiring a huge amount of disk space when working with uncompressed AVI format. After it’s all said and done, when you are ready to produce into MPEG or DV AVI format, valuable time is wasted again in compressing your movie!

Not so with PowerDirector’s proprietary technology, SVRT (Smart Video Rendering Technology). If your files are originally in MPEG or DV AVI format, editing will be in the same format and when producing, invaluable time and hard disk space is preciously saved when only the edited video portions need to be rendered. This is “smart video rendering”.
Chapter 9

Producing General MPEG-1 Files

As mentioned in the previous section, MPEG is the standard format this generation for compressed multimedia files with high quality. After you are satisfied with your all special effects, trims, audio, etc., and wish to produce a file in compressed MPEG format, you are ready for the final stage of your post-production process. Refer to “What Is MPEG?” on page 109 for more information.

1. Clips should be applied to the Storyboard.
2. Click Produce Movie located on the Modes Wheel.
3. Select MPEG-1 from the Video for General Purposes drop-down menu. Click Next.
We recommend that you select the default **Smart Video Rendering Technology (SVRT)** selection to save time. Refer to “Glossary” on page 111 for more information on this selection’s properties.

**Note:** If the SVRT is grayed out, it might be that your movie is utilizing Master Audio or Master Watermark or does not possess any MPEG files. SVRT is used optimally with MPEG formatted files.

If you are an advanced user, you may click the second selection **MPEG-1 Video (Constant Bitrate)**.

- If you picked the second selection, click on the left drop-down menu and choose the group of profiles you want to display, which will include Default, Custom, or All.

After selecting a group, select the specific profile. Profile properties will be displayed immediately below the chosen profile including the recommended processing speeds of your system. If you want better resolution or quality but at the expense of hard disk consumed, choose the higher quality or higher bitrate profiles.

**Tips:** If you will be making your own VCDs (burning at a later time), choose a VCD profile. For more information on television standards such as NTSC and PAL, refer to “NTSC and PAL” on page 110.
Click Details for more specific information concerning a profile.

To create your own profile, go to "Creating Custom MPEG Profiles" on page 94.

7 Click Next.

8 For the last step, choose a file name or click Browse to look for the correct directory. After finding the directory and typing in the new file name, click Save.

9 Check your File Details. Click Finish.

During the production, there are viewing options you may set. Go to "Preview Preferences" on page 43 for more information. You may also click Abort during production.

Save your project if you haven’t already by choosing File > Save. Enter the file name and click Save.
Producing Your Movie

Producing General MPEG-2 Files

As mentioned in the previous section, MPEG is the standard format for compressed multimedia files with high quality. After you are satisfied with your all special effects, trims, audio, etc., and wish to produce a file in compressed MPEG format, you are ready for the final stage of your post-production process. Refer to “What Is MPEG?” on page 109 for more information.

1. Clips should be applied to the Storyboard.
2. Click Produce Movie located on the Modes Wheel.
3. Select MPEG-2 from the Video for General Purposes drop-down menu. Click Next.

![Produce Movie Window]

4. We recommend that you select the default SVRT selection to save time. Refer to "Glossary" on page 111 for more information on this selection’s properties.

*Note: If the SVRT is grayed out, it might be that your movie is utilizing Master Audio or Master Watermark or does not possess any MPEG files. SVRT is used optimally with MPEG formatted files.*
If you are an advanced user, you may click the second selection **MPEG-2 Video (Constant Bitrate)**.

- If you picked the second selection, click on the left drop-down menu and choose the group of profiles you want to display, which will include Default, Custom, or All.

After selecting a group, select the specific profile. Profile properties will be displayed immediately below the chosen profile including the recommended processing speeds of your system. If you want better resolution or quality but at the expense of hard disk consumed, choose the higher quality or higher bitrate profiles.

**Note:** If you will be making your own DVDs (burning at a later time), choose a DVD profile.

- Click **Details** for more specific information concerning a profile.

- To create your own profile, go to “Creating Custom MPEG Profiles” on page 94.
7 Click Next.

8 For the last step, choose a file name or click Browse to look for the correct directory. After finding the directory and typing in the new file name, click Save.

9 Check your File Details. Click Finish.

- During the production, there are viewing options you may set. Go to "Preview Preferences" on page 43 for more information. You may also click Abort during production.
- Save your project if you haven’t already by choosing File > Save. Enter the file name and click Save.
Creating Custom MPEG Profiles

1. Either if you were in the Producing Movie process after you have chosen MPEG as your video type and selected **MPEG-1/2 Video (Constant Bitrate)**, or in the Capture Mode and in the process of selecting a profile, to create a custom profile you must first select an existing MPEG profile that is closely associated with your new profile.

2. Then, click **New...** in order to create a new MPEG profile. A dialog box appears.

3. Type in a profile name and edit the description. For information on the Profile Properties, go to "Glossary" on page 111 for more information.

4. Click on the **Video** tab.

   - Select a **Video Size** by clicking on the drop-down menu.

5. Drag the slider to set your **Video Compression Rate**. The higher the kbps, the less the compression with better quality, but more disk space will be consumed.

6. Some **Advanced Settings** may be checked as default depending on the profile you are copying from:
   - **Smoothing**: Check for a smoother image if you find video content is too fine and on the grainy side.
   - **Noise Removal**: This removes video artifacts such as white noise from video signals.
   - **Deinterlacing**: Combines two interlaced fields into a single frame and render them at 30 frames per second (fps). Deinterlacing is done to remove artifacts and improve the quality of encoded video.

7. Drag the **Speed Quality Indicator** to the left for higher speed but which will sacrifice quality or to the right for better quality but at a slower speed.
8  Click on the **Audio** tab.

9  The default MPEG Audio Compression setting will be Layer II stereo. For the **Audio Compression Rate**, like its Video counterpart, the higher the kbps, the less the compression with better quality, but more disk space will be consumed.

10 Click **OK** to return to the production/capture process.

   - To select your new profile, select **Custom** from the profile group menu and then select the profile.

   - To edit existing profiles, select the right custom profile and click **Edit**. Click **Delete** after you have selected the custom profile you wish to delete.
Chapter 9

Producing Windows Media Files

Streaming technology has grown by leaps and bounds since its increasing usage from the last decade by providing a medium that is controlled by the content provider and therefore is free of copyright issues. And it’s only getting started.

**Info:** Streaming utilizes video scaling, compression techniques, and network protocols in order to transmit files from a Web server (where the streaming file is stored) to the client (your hard drive). The concept of streaming is relatively easy: the file is broken up into data packets, compressed, and sent over the Internet in a stream, or a series of related packets, along with the audio data if applicable.

The client must have a player in order to decompress the packets, display the video data, and send audio data to the speakers via the sound card. The player will first buffer the packets, meaning the packets are downloaded and stored in a buffer before playback begins. This ensures smooth playback in case of breaks or interference due to unstable Internet connections. Thus, the client and its player does not have to wait for the entire file to download in order to begin playing the individual data packets.

Windows Media is a proprietary streaming audio/video format typically used to download and play files or to stream content. It is the main streaming format used for Microsoft’s Windows Media Player.

The Windows Media profiles are best for streaming content across bandwidths where you, the presenter, would like as many flexible selections as possible. Profiles range from the more basic Internet connection speeds to full-fledged broadband, audio only, and profiles containing single to multiple video streams.

After you are satisfied with your all special effects, trims, audio, etc., and wish to produce a file in compressed streaming Windows Media format, you are ready for the final stage of your post-production process.

1. Click **Produce Movie** located on the Modes Wheel.
2. Select **Windows Media** from the Video for General Purposes drop-down menu and click **Next**.

3. Now select a profile depending on what type of connection speed you will be utilizing when streaming your file to your audience. Click on the drop-down menu and select a profile. Profile descriptions and properties will be displayed immediately below the chosen profile. Go to “Glossary” on page 111 for more details. Click **Next**.
For the last step, choose a file name or click **Browse** to look for the correct directory. After finding the directory and typing in the new file name, click **Save**.

Check your File Details. Click **Finish**.

Save your project if you haven’t already by choosing **File > Save**. Enter the file name and click **Save**.
Producing AVI Files

PowerDirector has the robust feature of writing directly to your DV tape in AVI format when producing. This will include all your manipulation, modifications and special effects and is just another way of making your production more mobile and timeless. You may also produce in uncompressed AVI format to your hard drive.

1. Click Produce Movie located on the Modes Wheel.

2. Select AVI from the Video for General Purposes drop-down menu and click Next.
3  We recommend that you select the default SVRT selection to save precious time and render like never before!

Note: If the SVRT is grayed out, it might be that your movie is utilizing Master Audio or Master Watermark or does not possess any DV AVI files. SVRT is used optimally with DV AVI formatted files.

4  For the Profile field, click on the left drop-down menu to display the profile group. The DV group consists of DV format profiles while the Windows group is the uncompressed AVI format that will take up a large amount of hard disk but is used for editing by some video editing software applications and also writing to VHS tapes or for TV broadcast.

- Refer to "The DV Format: A Brief History" on page 3 for more information. For information on television standards such as NTSC and PAL, refer to "NTSC and PAL" on page 110.

5  After selecting the profile group, select the specific profile with the right drop-down menu. Profile properties will be displayed immediately below the chosen profile. Click Details for more information on a specific profile. Click Next.

- To adjust and modify a Windows AVI profile, go to “Setting AVI Profiles” on page 102.

- If your FireWire connection is ready, your DV camcorder is on, and your DV tape is in place, check Write to DV Tape to directly write your entire production onto your camcorder’s tape. Click Next.

Note: The Write to DV Tape step will appear after your production is complete.
6 For the last step, enter a file name or click **Browse** to look for the correct directory. After finding the directory and typing in the new file name, click **Save**.

![Production Wizard](image)

7 Check your File Details. Click **Finish**.

- If you decided to Write to DV Tape, after your movie is produced (hard disk version), the DV Tape dialog box will be displayed. Click **Show Preview** to preview when writing and then click **Start**. Click **Close** after it is complete.

![Write to DV Tape](image)

8 Save your project if you haven’t already by choosing **File > Save**. Enter the file name and click **Save**.
Chapter 9

Setting AVI Profiles

You may set the parameters of default Windows AVI profiles. For more information on the individual settings, go to "Glossary" on page 111 for more information.

Note: You may not set DV profiles.

1. While in the Producing Movie process, after you have chosen AVI as your video type, select an existing AVI profile to set.

2. Click Settings...

3. The Compression tab is the default. Select a Compression Codec by clicking on the drop-down menu. Refer to "codec" on page 111 for more information.

4. The Key Frame is unavailable to be set. It is defined as a frame in a video sequence that does not require information from a previous frame for decompression. The more the key frames, the better the quality but at the expense of disk space.

5. Click on the Data Rate drop-down menu and select one. The higher kbps, the better quality but at the expense of hard disk consumed.

6. Select the Composition if you only prefer video or audio.

7. Drag the slider to set your Quality.

8. Click on the Video/Audio Settings tab. Go to "Glossary" on page 111 for more information on specific terms.

9. Select a Frames x per second by clicking on the drop-down menu. The more motion you have in your video content, the higher the frame rate setting should be. The standard TV frame rate (e.g. NTSC) is 30.

10. Select a Video Size by clicking on the drop-down menu.

11. Select a Color by clicking on the drop-down menu.
For the Audio Setting, click on the drop-down menu for Format and Attributes and select for each one. PCM is the default. Go to "PCM" on page 113 for more information. For the attributes, the higher the Hz, the better quality but at the expense of hard disk space.

Click OK to return to the production process.
Chapter 9

Producing Movies on a Disc

1. Click **Produce Movie** located on the Modes Wheel.

2. Select **Video for Movie Disc Production**.

3. Select a **Type of Disc** from the drop-down menu and then a video format from the **Country/Video Format of Disc** menu.

4. Click **Next**.
5 For the last step, enter a file name or click **Browse** to look for the correct directory. After finding the directory and typing in the new file name, click **Save**.

![Step 2: Specify File Name](image)

6 Check your File Details. Click **Finish**.
CHAPTER 10: TECHNICAL SUPPORT

Before asking CyberLink Corp. for technical support, please refer to this user’s guide or online help for more information. You may also contact your local distributor/dealer. If your problem is still not resolved, the following sections provide ways to obtain technical support.

Web Support

Solutions to your problem are available 24 hours a day at our Web sites in Taiwan, USA, or Japan:

support.gocyberlink.com
www.gocyberlink.com
www.cli.co.jp

You may also find solutions in the FAQ section or at our Web sites. In addition to frequently asked questions, we also provide troubleshooting techniques, the latest in product news, and other relevant information.

Fax Support

In order to answer your technical questions as quickly as possible, you may fax us at: (886) 2-8667-1467.

Note: Technical support is only offered to registered users, so please make sure to jot down your serial number located on your CD case when visiting our Web sites or faxing.
Telephone Support

You are welcome to call the CyberLink’s Technical Support Hotline at (886) 2-8667-1298. Phone support hours are Monday to Friday, 9:00 AM-5:00 PM (GMT +8:00) Taiwan local time excluding holidays. When calling for support, please have your computer ready and provide us with the following information:

- your registered serial number
- the product version
- Windows’ OS version
- hardware types (capture card, sound card, VGA card) and their specifications
- warning messages displayed
- detailed problem description and when it occurred

Note: Technical support is only offered to registered users, so please make sure your serial number is ready when calling.
What Is MPEG?

MPEG, simply, is an acronym short for the Moving Picture Experts Group which belongs to the family of ISO/IEC standards (International Organization for Standardization and International Electrotechnical Commission). It is a compression technology for digital video and audio signals intended for consumer distribution. Included in the MPEG family are:

- MPEG-1 (Audio/Video)
  - MP3 or MPEG-1 Audio Layer 3 (Audio)
- MPEG-2 (Audio/Video)
- MPEG-4 (Interactive Multimedia System)
- MPEG-7 (Multimedia Database & Retrieval)

MPEG technology is defined as a bit-stream representation for synchronized digital audio and digital non-interlaced or interlaced (MPEG-2 includes both) video compressed to fit into a certain bandwidth:

- MPEG-1 -- 1.5-4.0 Mbps (megabits per second)
- MPEG-2 -- 4.0-10.0 Mbps

MPEG is responsible for multiplexing and synchronizing one video stream with a single or multiple audio streams. MPEG-1 was designed to reproduce VHS/VCR quality in a digital format, while the MPEG-2 concept, similar to MPEG-1, is intended to cover a wider range of applications including DVD quality and its primary goal of all-digital transmission of broadcast TV at coded bitrates between 4 and 9 Mbps.
Appendix

NTSC and PAL

The NTSC (National Television Systems Committee) and PAL (Phase Alternating Line) are television standards used for commercial television broadcasting around the world. Both NTSC and PAL use interlaced content at 30 frames per second (i.e. 60 fields) and 25 frames per second (i.e. 50 fields) respectively.

Because fields in interlaced signals are independent of other fields within a given frame, problems arise when two fields containing different imagery data are interleaved for display on non-interlaced computer monitors. When video imagery with superfluous movement is displayed, it usually causes motion artifacts (visual imperfections) and is why deinterlacing in bob mode with PowerDVD XP is needed. DVD titles whose content originates directly from films produced from Hollywood studios (24 frames/second) won't possess motion artifacts.
GLOSSARY

ASF  | Short for Advanced Streaming Format, a streaming multimedia file format developed by Microsoft for Windows 98. Term is currently used interchangeably with WMA and WMV.

bitrate  | Bitrate denotes the average number of bits that one second of video/audio data will consume.

codec  | Short for video COMpression and DECompression. Each codec uses a different algorithm to compress and decompress video data. Without codecs, storing and playing back digital video would be impractical. Common codecs include Indeo, Cinepak, RLE, MS Video 1, and MPEG.

deinterlace  | Deinterlaces interlaced video content, especially from TV signals and is mainly used to display interlaced video programs on non-interlaced computer monitors (see "interlaced video content" on page 112 for more information).

DSL  | See xDSL.

DV  | Digital Video. Refers to the capturing, manipulation and storage of video in digital formats. The DV format is an international standard intended for consumer use created back in 1995 by a consortium of companies.

DVD  | Digital Versatile Disc. DVD is a high capacity CD-size disc for video, multimedia, games and audio applications.

flip video  | This option is for certain video formats (such as YUY2) provided by some hardware capture devices which will might be displayed as upside-down during recording.

fps  | Frames Per Second. A measure of how much information is used to store and display motion video. The term applies equally to film video and digital video. Each frame is a still image; displaying frames in quick succession creates the illusion of motion. The more frames per second (fps), the smoother the motion appears. In
<table>
<thead>
<tr>
<th>Glossary</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>general, the minimum fps needed to avoid jerky motion is about 30. Some computer video formats, such as AVI, provide only 15 frames per second.</td>
<td><strong>frame rate</strong> For video content, the frame rate measures how many still frames per second. The higher the better when capturing video content with motion.</td>
</tr>
<tr>
<td>Group of Pictures. A MPEG compression technology, the GOP concept reduces the temporal redundancy across frames (from frame to frame) for video content and consists of I, B, P frames.</td>
<td><strong>GOP</strong></td>
</tr>
<tr>
<td>Is an attribute of colors that permits them to be classed as red, yellow, green, blue, or an intermediate between any contiguous pair of these colors.</td>
<td><strong>hue</strong></td>
</tr>
<tr>
<td>A.k.a. intra pictures, I-frame is typically the first frame of each GOP (apart of video compression technology used by MPEG), is moderately compressed, and serves as the reference points for random access and can be likened to images.</td>
<td><strong>I-frame</strong></td>
</tr>
<tr>
<td>Describes video content within a given frame where there are 2 imagery data fields, even and odd, that is scanned separately (e.g. NTSC and PAL television signals). This usually poses a problem when interlaced content meets non-interlaced mediums like computer monitors, which only displays non-interlaced content.</td>
<td><strong>interlaced video content</strong></td>
</tr>
<tr>
<td>Integrated Services Digital Network. Provides a user up to 56 kbps of data bandwidth on a phone line that is also used for voice, or up to 128 kbps if the line is only used for data.</td>
<td><strong>ISDN</strong></td>
</tr>
<tr>
<td>Kilobits per second. See bitrate.</td>
<td><strong>kbps</strong></td>
</tr>
<tr>
<td>Kilohertz. Hertz (Hz) is a unit of frequency equal to one cycle per second. One kHz is 1000 complete cycles per second.</td>
<td><strong>kHz</strong></td>
</tr>
<tr>
<td>Local Area Network. A computer network that spans a relatively small area. Most LANs are confined to a single building or group of buildings and mainly connect workstations and personal computers.</td>
<td><strong>LAN</strong></td>
</tr>
<tr>
<td>Multibitratre codecs allow several streams of different bitrates to be bundled into one file. The streaming server then communicates with the end user's media player to determine the optimum speed for delivery.</td>
<td><strong>MBR</strong></td>
</tr>
<tr>
<td>Mono is a single audio channel for lowest bitrate consumption.</td>
<td><strong>mono</strong></td>
</tr>
</tbody>
</table>
### Glossary

#### MPEG
Moving Picture Experts Group. A family of international standards used for coding audio/video information into digital format. Currently, MPEG-2 is the standard for digital video formats and MP3 for strictly digital audio formats.

#### non-interlaced video content
Describes video content within a given frame that does not consist of distinct imagery data fields. (e.g. computer monitors)

#### noise removal
Removes video artifacts such as white noise from video signals.

#### NTSC
National Television Systems Committee. Is a standard format adopted by the FCC for television broadcasts in the United States, Japan, Canada, and Mexico. Specifications: 525 lines of resolution per frame at 30 fps.; 60 Hz field frequency; requires a 6 MHz analog channel for transmission.

#### PAL
Phase Alteration Line. Is the standard format for television broadcasts in Germany, Great Britain, South America, Australia, and most of Western European and Asian countries.

#### PCM
Pulse Code Modulation. Is a sampling technique for digitizing analog signals, especially audio signals. PCM samples the signal 8000 times a second; each sample is represented by 8 bits for a total of 64 kbps. There are two standards for coding the sample level. The Mu-Law standard is used in North America and Japan while the A-Law standard is use in most other countries.

#### resolution
A synonym for sharpness in regards to imagery detail, it is measured in lines or pixels.

#### sampling rate
Sampling rate determines the sound frequency range (corresponding to pitch), which can be represented in digital waveform. The range of frequencies represented in a waveform is often called its bandwidth.

#### saturation
Is chromatic purity: freedom from dilution with white.

#### smoothing
Smooths out image if you find video content is too fine and on the grainy side.

#### stereo
Short for stereophonic and developed in the 1950’s, it constitutes sound reproduction using two independent audio channels.
## Glossary

**SVRT**  
Smart Video Rendering Technology. A proprietary CyberLink technology, SVRT saves vast amounts of time when producing movies that contain compressed MPEG files because it only renders edited portions. This preserves the quality of unrendered video portions of the original MPEG files.

**VCD**  
Video Compact Disc. Generally for video applications employing MPEG-1 technology, video quality is not as detailed as DVD and has similar technology to that of audio CDs.

**Video overlay**  
Video overlay is the ability to superimpose computer graphics over a live or recorded video signal and store the resulting video image on hard disk.

**Windows Media Format**  
This format is optimized for streaming and playing back audio, video, and script data and is primarily used in streaming presentations over the Internet. The main format used is .WMV in combination with Microsoft’s Windows Media Player.

**Windows Media Services Server**  
The Windows Media Services server offers the ability to provide multimedia content to a large number of clients using .WMV, .ASF, .WMA, .MP3 and .WAV formats. It is for the expanded use of streaming media such as live broadcasting and intelligent streaming and is, by default, the best way to stream media since it was designed especially for streaming. It also provides sufficient tools and support for traffic management and broadcasting streaming services. This differs from HTTP (Hypertext Transfer Protocol) streaming, which is directly streamed from Web servers.

**WMA**  
Windows Media Audio. A Windows Media proprietary streaming audio format typically used to download and play files or to stream content.

**WMV**  
Windows Media Video. A Windows Media proprietary streaming audio/video format typically used to download and play files or to stream content and is the main streaming format used for Microsoft’s Windows Media Player.

**xDSL**  
Refers collectively to all types of Digital Subscriber Lines, the two main categories being ADSL and SDSL. Two other types of xDSL technologies are High-data-rate DSL (HDSL) and Symmetric DSL (SDSL). DSL technologies use sophisticated modulation schemes to pack data onto copper wires. They are sometimes referred to as last-mile technologies because they...
are used only for connections from a telephone switching station to a home or office, not between switching stations.
INDEX

Numerics
1 to 1 Fill
  images 65
  video 62
1 to 1 Fit
  images 64
  video 62

A
advanced settings 94
altering speeds. See Speed Mode
analog
camcorders 5, 45
devices 1
generation 4
signals 113
antenna 47
applying
  image color filters 85
  eyedropper tool 85
  in modes. See specific mode for details
to Storyboard 11, 28, 29
ASF format 111
audio capture. See Capture Mode, audio capture
audio compression rate 95
audio files. See Audio Mode
Audio Mode
  adding audio files 25, 80
  applying 81
  clearing effects 25, 81
  fading in 80
  fading out 80
Master Audio. See Master Audio
  removing audio files 25, 81
  repeating audio files 80
  reverting 25, 81
  trimming audio files 25, 80
    applying 80
    visual overview 13, 25
    volume mixing 25, 80
audio setup. See Capture Mode, audio capture
audio streams 109
autosaving captured files 41
AVI format 87, 112
  movies. See producing, AVI movies
profiles 100
  DV group 100
  video for general purposes 99
Windows group 100
  setting profiles of 102
  audio setting 103
    color 102
    composition 102
    compression 102
    compression codec 102
    data rate 102
    frames per second 102
    key frame 102
    quality 102
    video size 102
    writing in 99

B
background color 71
bandwidth 113
batch capturing 56
See also Capture Mode, DV capture
bitrate 111
buffer 42, 96

C

camcorders
DV 5, 45, 50
advent of 3
batch capturing from. See batch capturing
Camera mode 50
VCR mode 50, 53, 56
capture cards 5, 45
selecting source of 47
capture destination. See preferences, capture destination
Capture Mode
audio capture 14, 48
audio CD source 48
device setup 48
input setup 48
profile setup 48
setup 48
capturing selection 47
capturing video and audio 46
DV capture 14, 50
adding batch task 18, 58
batch capturing 16, 18, 56
Camera mode 50
current time 15
instant capturing 16, 18
marking in 17, 58
marking out 17, 58
profiles 47, 51, 54, 57
removing batch task 18, 59
seek tape 15, 17, 55, 58
shuttling 16, 17, 55, 58
starting batch task 18, 58
total time 15, 55
using non real-time 16, 17, 50, 51, 53, 57
using real-time 16, 17, 50, 51, 53, 57
VCR mode 53
visual overview 15, 17
menu 36
recording 49, 52, 55
size limit 49, 52, 55
time limit 49, 52, 55
video capture 14, 46
antenna 47
CATV 47
device setup 47
setup 46
snapshot 49
tuner source 47
visual overview 13, 14
capture preferences. See preferences, capture
clearing. See specific mode for details
codec 111, 112
compression 102
composition 102
compression 95, 111
audio rate 95
codec 102
setting 102
techniques of 96
technology of 87, 112
video rate 94
country of disc 104
cropping
images 64
video 62
custom MPEG profiles. See MPEG, custom profiles of

d
data packets 96
data rate 102
deinterlacing 94, 111
deleting MPEG profiles 95
detecting scenes 9, 28, 31
advanced settings in 31
ignoring fade ins 32
ignoring flashing lights 32
removing scenes 32
setting sensitivity 31
through changing of timecodes 32
digital camera 5, 45
display preferences. See preferences, display
DSL 111
DV 4, 111
camcorders 5
buffer time 42
Camera mode. See camcorders, DV
capturing from 50
DVCAM format 3
DVCPro format 3
VCR mode. See camcorders, DV
See also camcorders, DV
Capture Mode of 36
visual overview 15, 17
See also Capture Mode, DV capture
capturing source of 14
format of 3
parameters setup 42
profiles 100
tape
previewing when writing 37
timecode 15, 17, 55, 58
writing multiples files to 37
writing to 37, 99, 100
universe of 3
DV AVI
detecting scenes with 32
introduction of 87
profiles of 52
used optimally with SVRT 100
writing to tape 37
DV VCR 45
DVD 111

E
editing MPEG profiles 95
Effects Mode
applying 71
background color setting 71

clearing effects 23, 71
effect length 71
effects settings’ table 69
foreground color setting 71
hold time 71
linked settings for 71
reverting 23, 71
supplying video effects 69
visual overview 13, 23
derting 23, 71
exitng PowerDirector 8
exporting 36

F
FireWire 4, 5, 45
flip video 111
foreground color 71
frame rate. See frames per second.
frames per second 94, 111

general preferences. See preferences, general
GOP 112

H
hardware requirements. See system requirements, hardware
hold time 71, 75
hue 112

I
I-frame 112
image color filters. See applying, image color filters
importing files. See Library, importing media
intelligent streaming 114
interlaced video content 109, 110, 112  
See also non-interlaced video  
content
i-Power 7, 38
ISDN 112

K
kbps 112
key frame 102
kHz 112

L
LAN 112
Library
  displaying as file details 9, 28
  displaying as large icons 9, 28
  importing directory 9, 27
  importing media 9, 27, 36
  removing from 28
  showing all audio files 9, 28
  showing all image files 9, 28
  showing all media files 9, 28
  showing all video files 9, 28
  visual overview 9

M
marking in
  See Capture Mode, DV capture
  See Titles Mode, marking in
marking out
  See Capture Mode, DV capture
  See Titles Mode, marking out
Master Audio 10
  clearing effects 83
  fade in 82
  fade out 82
  repeating 83
  reverting 83
trimming in 82
  applying 82
  volume mixing 83
Master Watermark 10, 86
  applying color filter in 86
MBR 112
  edit 37
  file 36
  help 38
  modes 37
  Storyboard 38
  minimizing PowerDirector 7
  Modes Wheel
    visual overview 13
  Modes. See specific mode
  mono 112
MPEG 87, 109, 112, 113
  audio compression setting of 95
  compared to DV format 3
  profiles 89, 90, 92
    custom 94
    video for general purposes 88, 91
    used optimally with SVRT 89
MPEG-1 114
  producing movies of. See
    producing, MPEG-1 movies
MPEG-2 113
  producing movies of. See
    producing, MPEG-2 movies

N
networks
  ISDN 112
  local area 112
  protocols 96
new project 36
next frame 11, 29
noise removal 94, 113
non-interlaced video content 109, 110, 113
non-linear editing 4
NTSC 110, 113
opening project 36
overlay. See video overlay

PAL 110, 113
parameters setup. See DV, parameters setup
pausing 11, 29, 62
PC camera 5, 45, 49
PCI
  capture cards 5, 45
PCM 113
Picture-in-Picture Mode
  applying 85
  applying image color filter 24, 85
  clearing effects 24, 85
  keeping aspect ratio 85
  reverting 24, 85
  selecting 84
  transparency setting 85
  visual overview 13, 24
playing files 11, 29
playing movie 10, 35, 43
ports 47
preferences 39
capture
  autosaving 41
  destination of 41
DV parameters setup 42
display
  Library tool tips 40
general
  applying clip preferences 39
  default directory 39
preview
  clip 43
  production process 43
  window size 43
Preview Mode 13
Preview Window 11
previewing
  during production 10, 35, 43

Library files 29
preferences. See preferences, preview
the Storyboard 28
title effects 75
transitions 77
when writing to DV tape 37, 101
previous frame 11, 29, 62
producing
  AVI movies 99
  from Storyboard clips 34
  movies on a disc 104
  MPEG-1 movies 88
  MPEG-2 movies 91
  preferences 43
  profiles. See profiles
  visual overview 13
  Windows Media movies 96
profiles
  AVI. See AVI format, setting profiles of
  DV AVI 52
  MPEG. See MPEG, profiles
  video for general purposes 47, 51, 54, 57
  video for movie disc production 47, 52, 54, 57
  Windows Media. See Windows Media, profiles
  properties of project 37

recent files 37, 40
recording 12, 16
  audio CD 49
Capture Mode. See Capture Mode, recording
  upside-down 111
removing
  audio files. See Audio Mode, removing audio files
  batch task. See Capture Mode, DV capture
  titles. See Titles Mode, removing
titles resizing images. See Trim Mode, for image files video. See Trim Mode resizing resolution 113 reverting. See specific mode for details

S

sampling rate 113 saturation 113 saving project 36 scenes. See detecting scenes seek tape. See Capture Mode, DV capture setup
  See Capture Mode, audio capture
  See Capture Mode, video capture shuttling 16, 17, 55 size limit. See Capture Mode, size limit slow motion. See Speed Mode Smart Video Rendering Technology 1, 87, 89, 91, 100 smoothing 94, 113 snapshot 16, 19 preferences 41 to clipboard 41 to file 41 to wallpaper 41 sound cards 96 speakers 96 Speed Mode applying 68 audio settings of 68 clearing effects 21, 68 decreasing speed 21, 67 increasing speed 21, 67 preserving original audio speed 68 reverting 21, 68 synchronizing audio with video 68 visual overview 13, 21 speed quality indicator 94 splitting video

in Trim Mode 19, 63 when detecting scenes 32 start of file 11, 29, 62 stereo 113 stopping 11, 15, 17, 29 Storyboard activating Master Audio 10 activating Master Watermark 10 applying audio files to 34 applying to. See applying, to Storyboard copying from 35, 37 cutting from 35, 37 deleting from 37 display preferences 40 functions of 34 moving clips 34 removing clips 34 going to 35, 38 menu 38 pasting on 35, 37 playing movie 10, 35 preferences 43 scrolling left 10 scrolling right 10 visual overview 10 streaming
  ASF format 111 format of 114 intelligent streaming. See intelligent streaming requirements for 5 server 112 technology 96 stretching
  images 64 video 62 system requirements 5

T

technical support 107 time limit. See Capture Mode, time limit
time slider 19, 29, 62
Web server 96, 114
Windows Media 96, 114
  Audio (WMA) 114
  Player 96, 114
  profiles 96, 97
    video for general purposes 97
Services server 114
Video (WMV) 114
Windows OS
  system requirements. See system
  requirements
WMA 114
WMV 114
writing to DV tape. See DV, tape

X

xDSL 114